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Save time and expense: use Adobe Acrobat to preview your

PageMaker files before you get them printed. It’s an excel-

lent way to proof your high-end job, especially when you

don’t have a PostScript printer.

Simply print your PostScript file from PageMaker, select-

ing “Write PostScript to File” in the Print Options dialog box

and specifying other desired

settings such as separations

(or use Printer Styles when you

create a PDF, if you prefer). Ei-

ther of these methods can mir-

ror your printer settings (Page-

Maker’s automated method of

creating a PDF may not). Open

the PostScript file in Acrobat

Distiller to create a PDF file.

Note: Distiller PE 2.1 (which

shipped with some versions of

PageMaker 6.0x) doesn’t allow

you to “manually” distill a PDF

as described above—you must

use the Create Adobe PDF plug-

in. To use Acrobat as a serious

proofing tool with PageMaker,

consider investing in the full retail version of Distiller. (Check

your version by choosing About Acrobat Distiller from the

Help menu in Windows or from the Apple menu on a Mac.)

You can install Acrobat Distiller and Reader on your com-

puter from the PageMaker 6.x CD-ROM.

Acrobat Reader is also available free of

charge on Adobe’s Web site.

Tip: Windows/Mac 6.x

You can view your PDF docu-

ment on screen or print it to

almost any kind of printer. For

more information on creating

PDF files, see chapter 13 of

your PageMaker User Guide.
Windows: After I had my PageMaker publication printed at

the service bureau, the text reflowed and all my line endings

changed. I made sure that my service bureau was using the

same fonts that I was. What happened?

Most likely, you and your service bureau weren’t using the

same printer driver. An absent or substituted font isn’t the only

thing that can cause text to reflow—this can also occur when a

change in printer drivers recomposes the text of the publication

at a different resolution than the one at which you’d been design-

ing. Knowing when and why this happens can help you prevent

text-flow surprises or work around them when they do happen.

Read on for details.

Text reflow occurs when the printer driver that’s specified in

the Compose To Printer pop-up menu in PageMaker’s Document

Setup dialog box (in version 6.x) or Page Setup dialog box (in ver-

sion 5.x) has been set incorrectly or changed to reflect a different

resolution. It’s common for this to happen when you change the

target printer late in the production process, perhaps right before
you rush out the door for your deadline. For example, suppose

you originally compose your document to your 600-dpi Post-

Script printer, and after completing the document you reset it to a

1200-dpi PostScript printer. Your text will recompose to the new

resolution, and as a result, text might reflow. It may not seem that

this should cause a monumental problem, but the inadvertent

addition of even one line can have far-reaching effects, especially

in a multi-page job.

There are also times when text might reflow when you haven’t

set out to change the Compose To Printer option, but circum-

stances have changed it for you. If you take a document to your

service bureau, unless they’ve installed the same printer driver

that you have, PageMaker will warn them that the driver wasn’t

properly loaded, and will change the Compose To Printer option

to ”?DISPLAY on None.” (Remember that in Windows the naming

convention for printer drivers is port-sensitive; the name that the

system looks for includes the port it was originally targeted to—

for instance, LPT1—or a network path.)

If you create publications that you take to an imagesetter or

other remote device for final output, follow this rule: when you

create a new publication in PageMaker, always select the final-

output device as your Compose To Printer option in the Docu-

ment Setup dialog box. For example, if your document will even-

tually be printed on a Linotronic 350 imagesetter, target the Lino-

tronic 350 when you create the publication. This will save you

from having to worry about recomposition problems, and you

can print it to your own printer for proofing. (If you’re printing to a

PostScript printer, it will simply print at the highest resolution it

can, and your line endings won’t change. If you’re printing to a

non-PostScript printer, see the tip at left for some helpful hints.)

Check with your service bureau or print shop to find out which

printer to target for the Compose To Printer option.

If your publication becomes composed to “?DISPLAY on None,”

don’t worry—this doesn’t have to be a crisis. In many cases, you

can avoid text recomposition and print your existing publications

as expected. If you don’t need to make changes that will force

PageMaker to recompose text (for instance, editing text or mov-

ing a graphic that has text wrap applied), go ahead and print the

publication. The text won’t recompose, and the line endings

won’t change. If you do need to make changes that will cause

PageMaker to recompose the text, you can always compose to a

printer that has the same resolution as the one your document

was originally composed to. PageMaker will then recompose the

publication at the same resolution, which, again, should prevent

any changes in line endings.

One final note: If you’ve used tracking and have edited your

PageMaker tracking values, remember to take your tracking-val-

ues file (“Trakvals.bin” in the USENGLSH subdirectory of the RSRC

subdirectory of your PageMaker directory) with you when you go

to the service bureau. If your customized tracking values are not

available, PageMaker will use whatever tracking values are avail-

able at print time (probably the default tracking values), which

could also make text reflow. If you’re using PageMaker 6.5, version

1.1 of the Save for Service Provider plug-in (now available on

Adobe’s Web site) automatically includes the tracking-values file

with the file package it prepares for you to take to your service

bureau. If you’re using PageMaker 6.x, you can use the Files for Re-

mote Printing option in the Save As dialog box to copy the track-

ing-values file to the same folder as your publication.
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Micro Tip

The proper-name

index entry function

is smart enough to

recognize whether

your entries are in

Last, First or First,

Last order. If it sees

Last, First, it will

know not to reinvert

them, so you’ll al-

ways get the right

name entry.

Automating the

insertion of index

entry markers

(called out in red

below, as shown in

PageMaker’s story

editor) makes short

work of a long list

of names.
Windows/Mac: I have a long list of business contacts that

I want to index for a directory in PageMaker. If I have to do

each one separately I think I’ll go crazy. Is there any way to

automate this process?

Fortunately for your sanity, yes. You can index proper names

quickly by setting up a separate text file, importing the file into

PageMaker, and performing the simple steps described here.

1. Format the names in the text file, making sure each one is its

own paragraph (that is, the name followed by a carriage return,

with no other text on the same line).

2. Use a nonbreaking space between words or initials you want

to keep together. For example, to index Henry David Thoreau,

type only a nonbreaking space between Henry and David.

(Leave just one regular space in each name right before the

word you want PageMaker to treat as the last name.) In Micro-

soft Word, press Ctrl + Shift + spacebar (Windows) or Option +

spacebar (Macintosh) to get the nonbreaking space character.
3. Apply a unique paragraph style to the names you want to in-

dex. (Don’t apply this style to any other text in your publica-

tion.) If you’re working with a text-only file, you can apply para-

graph-style tags instead. See “Importing text with style-name

tags” on page 344 of the PageMaker 6.5 User Guide, or page

287 of the PageMaker 6.0 User Guide, for more information

about using paragraph tags.

4. Import the text file into PageMaker, and then display the text

in the story editor.

5. Create index entries: Choose Change from the Utilities menu,

and then click Para Attributes. Select the paragraph style that’s

applied to the text for Find, and click OK. Type ^z (caret + z)—

the metacharacter for a proper-name index entry—in the

Change To text box. Click Change All if you want to create an

index entry for each name on your list. Click Change & Find if

you want to add entries selectively.
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Windows/Mac: I’ve added RAM to my PostScript printer, but

it hasn’t noticeably sped up printing from PageMaker. Can’t

PageMaker take advantage of this extra RAM?

Absolutely—but in order to do so, PageMaker has to know it’s

there. Generally, PageMaker depends on the PostScript Printer

Description (PPD) file to tell it how much free virtual memory

(VM) the printer has.

Note: The virtual memory in a printer isn’t like the virtual

memory in your computer, which uses a portion of the hard disk

as a substitute for real RAM. Virtual memory on a PostScript

printer is simply the amount of free memory the printer has avail-

able to process your job. Keep in mind that this number will be

somewhat smaller than the total amount of memory you have in

your printer, because the printer sets aside a portion of memory

for other purposes.

For PageMaker to take full advantage of the extra RAM, you

have to update your PPD to accurately reflect the VM amount.

Fortunately, PageMaker comes with an Update PPD utility that

makes it easy. For instructions on using Update PPD, refer to the

section in your Adobe PageMaker User Guide on creating a custom

PPD (pages 395–98 in the PageMaker 6.5 User Guide or 325–28 in

the PageMaker 6.0 User Guide, but Windows users please note: the

instructions erroneously give you the option to use the Update

PPD plug-in, which is not available in PageMaker 6.x; use the Up-

date PPD utility). You can also manually update a PPD; that pro-

cess is explained in Adobe technical document 100102, “Updating

PPD Files to Reflect Available Virtual Memory Using a Text Editor,”

available via the techdocs e-mail service or FaxYI (see pages 90–

91 for more information).

Windows/Mac: I’m using ATM 4.0 Deluxe, but the font auto-

activation feature doesn’t seem to work with PageMaker.

When I open up my document, I get the PANOSE warning

indicating that the fonts were not found. But I can see the

fonts on my hard disk, and when I check ATM, the fonts are

installed. I’d like these fonts to automatically activate when

I open a publication that requires them. How can I get this

to work properly?

In order to use the ATM Deluxe’s auto-activation feature in

PageMaker, you’ll need to do all of the following:

1. Use a version of PageMaker that supports auto-activation: On

the Windows 95 platform, only version 6.5x supports auto-acti-

vation. (The Windows NT version of ATM Deluxe doesn’t sup-

port auto-activation.) If you’re using a Macintosh, version 5.0x

or later will work.

2. Ensure that auto-activation is turned on in the ATM Deluxe

Control Panel: In Windows 95, open the ATM Control Panel and

select the Settings tab. Click Advanced and select Enable Auto-

Activation. On the Macintosh, open the ATM Control Panel and

choose Preferences from the File menu. At the bottom of the

General panel, make sure Enable Auto-Activation is set to ei-

ther By Application or Global.

3. Set Font Matching options correctly in PageMaker: If you’re us-

ing Windows 95, ensure that Allow Font Matching is checked in

the PANOSE Font Matching dialog box. If you’re using a

Macintosh, set PageMaker to use ATM font matching instead of

PANOSE. To do this, start PageMaker and choose Preferences

from the File menu (in PageMaker 6.5x, you’ll need to choose

General from the Preferences submenu as well) and click Map



Tip: Windows/Mac

Photoshop’s method for converting

CMYK colors for screen display (below)

can look better than PageMaker’s

(left)—but don’t worry, this doesn’t

affect printing.
Fonts. The Font Matching Preferences dialog box appears. If

you’re using Windows 95, select Allow Font Matching and click

OK. If you’re using a Macintosh, select ATM Font Matching

(PageMaker 6.x) or SuperATM Font Matching (PageMaker 5.x)

and then click OK.

Macintosh users please note: Even if you’ve specified PANOSE as

the font-matching system in Preferences, ATM auto-activation

will still function. You’ll get the PANOSE font-matching dialog box

when you open the document (indicating that the font couldn’t

be found and will be substituted), but ATM will activate the font;

it will display and print as you expect.

Windows/Mac: When I place a CMYK image into PageMaker,

the colors in the image look very different from how they

look in Photoshop. What’s going on?

PageMaker and Photoshop use different processes for display-

ing CMYK colors on your monitor. Because your monitor is ca-

pable of displaying color only in RGB, both applications have to

convert the CMYK colors in the image to RGB for on-screen view-

ing. To perform this conversion, PageMaker uses a built-in, nonad-

justable algorithm that contains instructions for mapping these

colors to the RGB gamut. In contrast, Photoshop depends largely

on the information in Monitor Setup to perform this conversion.

Because Photoshop is able to tailor the display of the image to

suit your monitor, the on-screen version of the image is likely to

be more appealing in Photoshop (assuming, of course, that your

monitor has been correctly calibrated and the information in your

Monitor Setup is correct).

To help you achieve a more consistent screen display of color

images between the two applications, you’ve got two basic op-

tions. If you don’t plan on doing color separations, or if you’re us-

ing a non-PostScript printer, the easiest way to get around the

problem is to save your images from Photoshop in RGB mode be-

fore bringing them into PageMaker. This way, rather than having

to convert the colors from CMYK to RGB, both applications will

send the RGB colors to the screen, relatively unfiltered. Keep in

mind that some minor differences may still exist, since Photoshop

still uses the information in Monitor Setup to display RGB images.

However, they should still look pretty similar, if not identical, be-

tween applications. In addition, because your monitor is capable

of reproducing more colors than your printer, you’re also likely to

see a greater discrepancy between the on-screen and the printed

version of the image.

If you’re planning on doing color separations or if you’d prefer

to continue working with CMYK images, you’ll need to use Page-

Maker 6.x’s color-management system (CMS) to bring Photoshop

and PageMaker into sync with one another.

There are a number of resources available to help you get

started working with color and using color management. For a

general introduction, refer to your Photoshop and PageMaker

User Guides and the Adobe Print Publishing Guide that’s included

with PageMaker. You might also find useful “Color Under Control”

by Bruce Fraser in the September/October 1995 issue of Adobe

Magazine. Finally, be sure to browse through Adobe’s online

support database at www.adobe.com/supportservice/custsupport/

database.html to download recently developed technical docu-

ments with explanations of and step-by-step instructions for

managing the CMS workflow in PageMaker and Photoshop. ◆
Make it snappy!
Here are some ways to optimize the level of performance

you get from PageMaker.

• For faster screen redraw when you’re using graphics,

select Gray Out under Graphics Display in the Preferences

dialog box.

• For faster screen redraw at views smaller than actual

size, select a larger pixel size for Greek Text Below in the

More Preferences dialog box. Text displays as gray bars

when the pixel size of the text at the selected magnifica-

tion view is smaller than the number entered for the

Greek Text Below option.

• Use the story editor to make text changes without

PageMaker redrawing the screen. Click your cursor in

a text block and choose Edit Story from the Edit menu.

• Store large graphics externally (that is, link them outside

your publication) to minimize a publication’s file size.

The smaller the file size, the faster PageMaker opens,

recomposes, and saves the publication.

• Split large publications into multiple, smaller publica-

tions, and use PageMaker’s Book feature to join them.

• Apply the Set Width, small caps, or tracking features only

during the final stages of formatting your publication;

they tend to decrease PageMaker’s redraw rate.

Macintosh users: For other “speed” hints, see Adobe techni-

cal document 216326, “Optimizing Performance in Page-

Maker 6.x for the Macintosh or Power Macintosh.”
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